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Paper Set 1 · 01 Jun 2026 · 12:30 PM - 2:00 PM · OSSSC CRE 2025 (English)

Quant

✓

Q1 Quant
For which value of k will the equation x² + kx + 441 = 0 have equal
roots?

A.  ±21

B.  ±42

C.  ±44

D.  ±22

✓

Q2 Quant
The side of a square is 5 cm more than the radius of a circle whose
circumference is 16π cm. What is the perimeter of the square?

A.  48 cm

B.  52 cm

C.  56 cm

D.  64 cm

✓

Q3 Quant
A shopkeeper buys an item for ₹200 and sells it for ₹250. What is the
percentage profit?

A.  25%

B.  20%

C.  30%

D.  15%

✓

Q4 Quant
John covers two-fifth of the total distance at 9 km/hr and the
remaining distance at 12 km/hr in the total duration of 6 hours 48
minutes. Find the distance covered by him at 12 km/hr.

A.  43.2 km

B.  28.8 km

C.  48.2 km

D.  34.8 km

✓

Q5 Quant
Which of the following numbers is divisible by 16?

(i) 8914266
(ii) 5282140
(iii) 4674032
(iv) 5463776

A.  ( ii ) and ( iv ) only

B.  ( i ) and ( iii ) only

C.  ( ii ) and ( iii ) only

D.  ( iii ) and ( iv ) only

✓

Q6 Quant
If a:b=6:17, then the value of (a+b):(b-a) is:

A.  21:13

B.  11:23

C.  13:21

D.  23:11

✓

Q7 Quant
A sample of 15 data is given as follow: 52.1, 54.7, 51.2, 55.9. 51.2,
57.4, 59.5, 55.9, 52.1, 55.9, 54.7, 52.1, 55.9, 51.2. Find the mode of
the data.

A.  52.1

B.  51.2

C.  54.7

D.  55.9

✓

Q8 Quant
X and Y started a business by investing ₹60,000 and ₹90,000,
respectively. After 6 months, X adds ₹30,000 more to his investment,
and Y withdraws ₹30,000. If the total profit at the end of the year is
₹1,20,000, what is Y’s share?

A.  ₹54,000

B.  ₹60,000

C.  ₹66,000

D.  ₹72,000
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✓

Q9 Quant
If 20% of a number is added to 24, then the result is the same
number. 80% of the same number is:314

A.  24

B.  6

C.  54

D.  44

✓

Q10 Quant
A and B working together can do a piece of work in 2 days. B alone
can do the same work in 5 days. How long (in days) will A alone take
to do thrice the work?2544

A.  10

B.  20

C.  30

D.  40

✓

Q11 Quant
A sum of ₹1,589 is divided into three parts such that half of the first
part, one-fourth of the second part, and one-eighth of the third part
are equal. What is the positive difference (in ₹) between the first and
the second parts?

A.  227

B.  177

C.  277

D.  77

✓

Q12 Quant
The profit made on a product is 24%. What is the loss percentage
(correct to two decimal places) incurred on the sale if the figures of
both cost price and selling price are interchanged?3172

A.  19.35%

B.  23.01%

C.  19.33%

D.  19.54%

✓

Q13 Quant
If the compound interest on a sum of ₹y at 5% per year for 2 years,
compounded annually, is ₹287, what will be the amount after 2
years?

A.  ₹3087

B.  ₹2801

C.  ₹3551

D.  ₹2694

✓

Q14 Quant
P, Q, R, S and T in the given order are points on a circle, such that PR
is a diameter and PQ = QR. If ∠STP = 124°, then what is the degree
measure of ∠SPQ?

A.  79°

B.  34°

C.  72°

D.  45°

✓

Q15 Quant
Two circles touch each other externally at point A. BC is a common
tangent to both the circles touching the circles at point B and point
C. If the radii of the circles are 8 cm and 3 cm, and length of BC = x
cm, find the value of x2.

A.  90

B.  92

C.  94

D.  96

✓

Q16 Quant
In what time (in months) will ₹3300 fetch an interest of ₹440 at 5%
per year simple interest?

A.  32

B.  29

C.  30

D.  36

✓

Q17 Quant
A number when increased by 60%, gives 3490. The number is:

A.  2181.25

B.  2362.54

C.  1090.62

D.  1543.75

✓

Q18 Quant
Two persons X and Y travel the same distance at the speeds of 14
km/hr and 15 km/hr, respectively. If X takes 28 minutes more than Y,
the distance travelled by each is:

A.  84 km

B.  90 km

C.  60 km

D.  98 km

https://play.google.com/store/apps/details?id=in.qmaths.blackbook&referrer=src%3Dosssc_cre25
https://rank.qmaths.in


✓

Q19 Quant

A.  

B.  

C.  

D.  

✓

Q20 Quant
A and B can do a piece of work in 5 days, B and C can do it in 8 days, C and A can do it in 10 days. Find the time taken by B alone to complete
this work.

A.  

B.  

C.  

D.  

GA

✓

Q21 GA
Which Indian city hosted the Hockey India Masters Cup 2025 (Men &
Women) from June 18 to 27?

A.  Chennai

B.  Mumbai

C.  Kolkata

D.  New Delhi

✓

Q22 GA
Who among the following is the first boxer to win a gold medal at
the World Boxing Cup in 2025?

A.  Vijender Singh

B.  Hitesh Gulia

C.  Amit Panghal

D.  Nishant Dev

✓

Q23 GA
Who among the following won the 10 km Austrian Race Walking
Championships 2025?

A.  Bhawna Jat

B.  Khushbir Kaur

C.  Priyanka Goswami

D.  Sapana Punia

✓

Q24 GA
Which among the given groups of rivers in Odisha have their source
outside the state?

A.  Budhabalanga, Baitarani, Rushikulya

B.  Subarnarekha, Brahmani, Mahanadi

C.  Bahuda, Vamsadhara, Nagavali

D.  Indravati, Kolab, Machkund
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✓

Q25 GA
Which Odia social worker and Gandhian founded Sewaghar at Bari
and later set up Shishu Vihar at Cuttack?

A.  Rama Devi Choudhury

B.  Malati Choudhury

C.  Sarala Devi

D.  Annapurna Maharana

✓

Q26 GA
Where did the 2025 UCI Track Cycling World Championships take
place?

A.  Chile

B.  China

C.  Brazil

D.  Rwanda

✓

Q27 GA
In early July 2025, the Baitarani River bank collapse near Nuapatna
took place in which Odisha district?

A.  Balasore

B.  Jajpur

C.  Bhadrak

D.  Kendrapara

✓

Q28 GA
Which scheme in the Odisha Budget 2026–27 received ₹635 crore
for strengthening Anganwadi services?

A.  Samruddha Anganwadi Yojana

B.  Subhadra Yojana

C.  Mukhyamantri Kanya Sumangal Yojana

D.  Aahaar Yojana

✓

Q29 GA
How does the structure of sieve tubes facilitate the translocation of
food?

A.  Thick walls prevent leakage

B.  Perforated walls allow food movement

C.  No nucleus for faster transport

D.  Presence of chloroplasts

✓

Q30 GA
Which important river flows from north to east across northern
India?

A.  Narmada River

B.  Godavari River

C.  Ganga River

D.  Tapi River

✓

Q31 GA
Ancient Indian monastic discipline texts that codified rules
governing the conduct and organization of monks and nuns are
primarily associated with which literary tradition?

A.  Modern reformist prose writings of colonial India

B.  Dharmasutras of Vedic literature

C.  Vinaya pitaka of Buddhist literature

D.  Silappadikaram of Sangam literature

✓

Q32 GA
Which of the following explains why suspensions are considered
heterogeneous mixtures?

A.  The particles in suspension cannot be seen.

B.  The suspension is always clear and transparent.

C.  The particles are unevenly distributed throughout the
mixture.

D.  The particles are evenly distributed throughout the mixture.

✓

Q33 GA
Which gas is commonly known as laughing gas and also contributes
to global warming?

A.  Carbon dioxide

B.  Nitrous oxide

C.  Methane

D.  Ozone

✓

Q34 GA
Sangam literature was composed in which language?

A.  Tamil

B.  Sanskrit

C.  Prakrit

D.  Pali
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✓

Q35 GA
Which of the following Acts, enacted in 1857, introduced mandatory
licensing for running or owning a printing press?

A.  Lagging Act

B.  Bagging Act

C.  Gagging Act

D.  Magging Act

✓

Q36 GA
Which of the following sub-regions of the Northern Plains lies
closest to the Himalayan foothills?

A.  Bhabar

B.  Khadar

C.  Bhangar

D.  Terai

✓

Q37 GA
Which of the following is NOT a method of measuring poverty?

A.  Income Gap Index

B.  Head Count Index

C.  BSE Index

D.  The Sen Index

✓

Q38 GA
Panchayati Raj Institutions are mentioned under which of the
following Schedules of the Constitution of India?

A.  Seventh Schedule

B.  Eighth Schedule

C.  Eleventh Schedule

D.  Twelfth Schedule

✓

Q39 GA
Which one of the following planets is usually seen shining brightly at
dawn and dusk and is commonly called the Morning Star or the
Evening Star, even though it is not a star?

A.  Mars

B.  Mercury

C.  Venus

D.  Neptune

✓

Q40 GA
Ohm’s law is NOT applicable to which of the following?

A.  Copper wire

B.  Nichrome wire

C.  Filament of a bulb

D.  Resistor

English

✓

Q41 English
What is an unconventional style of living called?

A.  Blasphemy

B.  Bohemian

C.  Connoisseur

D.  Apostate

✓

Q42 English
Select the most appropriate option to fill in the blank.

Her voice had a ________ quality that made everyone in the room stop and listen.

A.  loud

B.  dull

C.  captivating

D.  harsh
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✓

Q43 English
Choose the sentence in which the spelling error in the given sentence has been corrected.

The commitee has decided to postpone the annual meeting until next month.

A.  The comitee has decided to postpone the annual meeting until next month.

B.  The committee has decided to postpone the annual meeting until next month.

C.  The commity has decided to postpone the annual meeting until next month.

D.  The commetee has decided to postpone the annual meeting until next month.

✓

Q44 English
Select the option that expresses the given sentence in active voice.

The documents were submitted by the students before the deadline.

A.  The students submitted the documents before the deadline.

B.  The documents were being submitted by the students.

C.  The students had submitted the documents before the deadline.

D.  The students submit the documents before the deadline.

✓

Q45 English
Select the option that can be used as a one-word substitute for the given phrase.

A feeling of intense longing for something

A.  Apathy

B.  Yearning

C.  Indifference

D.  Disdain

✓

Q46 English
Choose the correct direct speech option to complete the sentence.

She warned me not to open the file because it had a virus.
She said, “______________ a virus.”

A.  Don’t open the file because it had

B.  Not to open the file because it has

C.  I should not open the file because it had

D.  Don't open the file because it has
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✓

Q47 English
In the following question, a statement has been given in brackets. You are required to replace the statement with the correct proverb given in
the options.

When the city improved its public transport system, residents, businesses, and schools all benefited. It clearly showed that (everyone gains
when the overall condition improves).

A.  a rising tide lifts all boats

B.  charity begins at home

C.  fortune favours the brave

D.  one good turn deserves another

✓

Q48 English

Read the passage carefully and answer the questions that follow.

In a remote village in Rajasthan, water scarcity has shaped the lives of its residents for generations. Every drop of water is valued, and traditional
rainwater harvesting systems, known as “johads”, have been ingeniously used to store and channel water. Women and children walk miles daily
to fetch water, turning it into a communal activity that strengthens social bonds. Over time, modern interventions like solar-powered pumps have
complemented these age-old practices, improving efficiency without disrupting traditional methods. The village’s resilience lies not only in
technology but in the people’s collective awareness and adaptability. By preserving indigenous knowledge and embracing sustainable solutions,
the community ensures survival amid harsh climatic conditions. This delicate balance between tradition and innovation highlights the role of
human ingenuity in confronting environmental challenges. The story reflects how resource scarcity can foster cooperation, innovation, and
respect for natural systems.

What is a “johad” used for in the village?

A.  Storing and channeling water

B.  Farming crops

C.  Building houses

D.  Religious ceremonies

✓

Q49 English
What is the central theme of the passage?

A.  Modern technology replaces tradition

B.  Water scarcity and community resilience

C.  Women’s role in society

D.  Religious practices in villages

✓

Q50 English
What can be inferred about the village residents?

A.  They rely solely on modern technology.

B.  They are indifferent to environmental challenges.

C.  They value cooperation and sustainability.

D.  They have abandoned traditional practices.
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✓

Q51 English
What is the tone of the passage?

A.  Appreciative and informative

B.  Sarcastic

C.  Humorous

D.  Critical

✓

Q52 English
Which title best suits the passage?

A.  Innovation Amid Scarcity: Water Management in Rajasthan

B.  Village Festivals and Traditions

C.  The Rise of Solar Technology

D.  Women in Rural India

✓

Q53 English
The parts of a sentence are given below. While the first part (S1) is fixed and correctly placed, the remaining segments are jumbled. Rearrange
them to form a clear, meaningful, and grammatically correct sentence.

S1. She wanted
A. not come easily that evening
B. to her friend, but
C. the right words would
D. to explain everything

A.  CADB

B.  DBCA

C.  ACDB

D.  BCDA

✓

Q54 English

Replace the given word segment with the correct idiom.
To come very near to success but ultimately fail

A.  Get out of town

B.  Close, but no cigar

C.  Peas in the pod

D.  All bets are off

✓

Q55 English
Select the most appropriate ANTONYM of the highlighted word.

He believed that his daily routine was mundane and lacking excitement.

A.  ordinary

B.  expensive

C.  routine

D.  extraordinary
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✓

Q56 English
Select the word that is closest in meaning to the opposite of the highlighted word.
He felt desperate after hearing the bad news.

A.  Hopeful

B.  Content

C.  Relieved

D.  Assured

✓

Q57 English
Select the most appropriate option to fill in the blank.
If he studies hard, he _____ the exam.

A.  will pass

B.  will be passing

C.  will have passed

D.  is passing

✓

Q58 English
Complete the sentence by choosing the correct option.
Not only the parents but also the child ______ excited about the trip.

A.  are

B.  has

C.  is

D.  being

✓

Q59 English
Parts of a sentence are given below in jumbled order. Arrange the parts in the correct order to form a meaningful sentence.

P. your body stronger,
Q. if you want to make
R. exercise regularly
S. and eat healthy food

A.  QPRS

B.  PQSR

C.  RSPQ

D.  QRPS

✓

Q60 English
Select the most appropriate article to fill in the blank. If no article is needed, select 'No article required'.

She went to ___ market to buy vegetables.

A.  a

B.  an

C.  the

D.  No article required
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Odia

✓

Q61 Odia
କ୍ରି  ୟା ବି ଶେଷଣ ପଦ ବ୍ୟବହାର କରି  ବାକ୍ୟଟି କୁ  ସମ୍ପୂ ର୍ଣ୍ଣ  କର ।

''ଯେଉଁ  ମାନଙ୍କର ନି ର୍ଦ୍ଦିଷ୍ଟ ନୀତି  ନ ଥାଏ , ସେମାନେ ____ ବି ଭି ନ୍ନ ଲୋକଙ୍କ ଦ୍ୱାରା ପ୍ର ଭାବି ତ ହୋଇଥାନ୍ତି  ।''

A.  ଶାନ୍ତି ରେ

B.  ସହଜରେ

C.  ଦୁଃ ଖରେ

D.  ଈର୍ଷା ରେ

✓

Q62 Odia
"ଧୂ ଆଁ ବାଣ ମାରି ବା" ର ଅର୍ଥ ?

A.  ବଢ଼େଇ କରି  କଥା କହି ବା

B.  ସତ୍ୟ କହି ବା

C.  ଛଳ କରି ବା

D.  ବୋକା ବନେଇବା

✓

Q63 Odia
ସଠି କ ତତ୍ସମ ଶବ୍ଦ ବାଛନ୍ତୁ: “ଗାଁ ” ର ତତ୍ସମ କଣ?

A.  ଗ୍ରା ମ

B.  ଗ୍ର ମ

C.  ଗମ୍

D.  ଗ୍ରା ମୀ

✓

Q64 Odia
ଦି ଆଯାଇଥି ବା ଓଡ଼ି ଆ ବାକ୍ୟକୁ  ଇଂରାଜୀରେ ଅନୁ ବାଦ କର।

ମୋହନ ସ୍କୁଲ ଯାଉଛି ।

A.  Mohan is going to school.

B.  Mohan was going to school.

C.  Mohan had gone to school.

D.  Mohan has gone to school.

✓

Q65 Odia
ଦି ଆଯାଇଥି ବା ଓଡ଼ି ଆ ବାକ୍ୟକୁ  ଇଂରାଜୀରେ ଅନୁ ବାଦ କର।

ପ୍ର ତି  ମଙ୍ଗଳବାର ଦି ନ ତୁ ମେ ହନୁ ମାନ ମନ୍ଦି ର ଯାଅ କି  ?

A.  Have you gone to Hanuman Mandir every Tuesday?

B.  Do you go to Hanuman Mandir every Tuesday?

C.  Will you go to Hanuman Mandir ?

D.  Are you going to Hanuman Mandir every Tuesday?
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✓

Q66 Odia
ଦି ଆଯାଇଥି ବା ଓଡ଼ି ଆ ବାକ୍ୟକୁ  ଇଂରାଜୀରେ ଅନୁ ବାଦ କର।

କେରଳ ରେ ପ୍ର ତି ଟି  ଘରେ ନଡି ଆ ଗଛ ଲାଗି ଛି  ।

A.  In Kerala, every house has a coconut tree.

B.  In Kerala, every house had a coconut tree.

C.  There are so many coconut trees In Kerala.

D.  In Kerala, every house has a tree.

✓

Q67 Odia

ନି ମ୍ନ ଲି ଖି ତ ଅନୁ ଚ୍ଛେଦର ବି ଷୟବସ୍ତୁକୁ  ଭଲଭାବରେ ପଢ। ତା ତଳେ ପ୍ର ଦତ୍ତ ପ୍ର ତ୍ୟେକ ପ୍ର ଶ୍ନ ର ଚାରି ଟି  ସମ୍ଭାବି ତ ଉତ୍ତର ମଧ୍ୟରୁ  ସଠି କ ଉତ୍ତରକୁ  ଚୟନ କରନ୍ତୁ|

ଭାରତରେ ନଦୀଗୁ ଡ଼ି କର ପରସ୍ପର ସଂଯୋଗୀକରଣ ଏକ ପ୍ର ମୁ ଖ ଜଳ-ପରି ଚାଳନା ପଦକ୍ଷେପ | ଏହି  ପଦକ୍ଷେପରେ ଉଦ୍ ‌ବୃ ତ୍ତ ନଦୀ ଅବବାହି କାରୁ  ଅଭାବୀ ନଦୀ ଅବବାହି କାକୁ  ଜଳ ସ୍ଥାନାନ୍ତର କରି
ଜଳ ଉପଲବ୍ଧତାରେ ଆଞ୍ଚଳି କ ଅସନ୍ତୁଳନକୁ  ଦୂ ର କରି ବା ପାଇଁ  ଲକ୍ଷ୍ୟ ରଖାଯାଇଛି । ବନ୍ୟା, ମରୁ ଡ଼ି  ଏବଂ କୃ ଷି  ସ୍ଥାୟୀତ୍ୱ ସମ୍ବନ୍ଧୀୟ ଚ୍ୟାଲେଞ୍ଜଗୁ ଡ଼ି କର ସମାଧାନ ପାଇଁ  ପରି କଳ୍ପି ତ, ଏହି  ଧାରଣା 19
ଶତାବ୍ଦୀର ହେଲେ ସୁ ଦ୍ଧା ଏହା ସ୍ୱାଧୀନତା ପରବର୍ତ୍ତୀ  ଯୁ ଗରେ ଜାତୀୟ ସ୍ବୀ କୃ ତି  ପାଇଲା। 1980 ମସି ହାରେ ଆରମ୍ଭ ହୋଇଥି ବା ଜାତୀୟ ଦୃ ଷ୍ଟି କୋଣ ଯୋଜନା (NPP), ଦୁ ଇଟି  ପ୍ର ମୁ ଖ ଉପାଦାନ -
ହି ମାଳୟ ଏବଂ ଉପଦ୍ୱୀପ ନଦୀ ପ୍ର ଣାଳୀକୁ  ନେଇ ଏକ ବ୍ୟାପକ ନଦୀ ସଂଯୋଗୀକରଣ ରଣନୀତି ର ମୂ ଳଦୁ ଆ ସ୍ଥାପନ କରି ଥି ଲା। ଏହି  ଦୃ ଷ୍ଟି କୋଣ ଅଧୀନରେ, 30 ରୁ  ଅଧି କ ନଦୀ ସଂଯୋଗ ପ୍ର କଳ୍ପ
ଚି ହ୍ନଟ କରାଯାଇଥି ଲା, ଯେଉଁ ଥି ରେ କେନ୍ -ବେତୱା ଲି ଙ୍କ୍ , ଗଙ୍ଗା-କାବେରୀ ଲି ଙ୍କ୍  ଏବଂ ପାର-ତାପି -ନର୍ମ ଦା ଲି ଙ୍କ୍  ଭଳି  ଜଣାଶୁ ଣା ପ୍ର ସ୍ତାବ ଅନ୍ତର୍ଭୁ କ୍ତ। ଏହାର ଉଦ୍ଦେଶ୍ୟ ହେଉଛି  ଏକ ସଂଯୁ କ୍ତ ଜଳ
ନେଟୱାର୍କ  ସୃ ଷ୍ଟି  କରି ବା ଯାହା ଅତି ରି କ୍ତ ମୌସୁ ମୀ ଜଳକୁ  ମରୁ ଡ଼ି  ପ୍ର ବଣ ଅଞ୍ଚଳକୁ  ଫେରାଇପାରି ବ, ଜଳସେଚନକୁ  ବୃ ଦ୍ଧି  କରି ପାରି ବ, ପାନୀୟ ଜଳ ଯୋଗାଣକୁ  ବୃ ଦ୍ଧି  କରି ପାରି ବ, ଆଭ୍ୟନ୍ତରୀଣ ଜଳ
ପରି ବହନକୁ  ଉନ୍ନତ କରି ପାରି ବ ଏବଂ ଜଳବି ଦ୍ୟୁ ତ୍  ଶକ୍ତି  ଉତ୍ପାଦନ ବୃ ଦ୍ଧି  କରି ପାରି ବ।

ସମ୍ପ୍ରତି  ଅନୁ ମୋଦି ତ କେନ୍ -ବେତୱା ପ୍ର କଳ୍ପକୁ  ଜାତୀୟ ଆନ୍ତଃସଂଯୋଗ କାର୍ଯ୍ୟ କ୍ର ମ କାର୍ଯ୍ୟ କାରୀ କରି ବା ଦି ଗରେ ପ୍ର ଥମ ପ୍ର ମୁ ଖ ପଦକ୍ଷେପ ବୋଲି  ବି ବେଚନା କରାଯାଉଛି । ଯଦି  ସଫଳତାର ସହ
କାର୍ଯ୍ୟ କାରୀ ହୁ ଏ, ତେବେ ଏହା ଉତ୍ତରପ୍ର ଦେଶ ଏବଂ ମଧ୍ୟପ୍ର ଦେଶର ଅଞ୍ଚଳଗୁ ଡ଼ି କୁ  ଜଳସେଚନ, ପାନୀୟ ଜଳ ଏବଂ ବି ଦ୍ୟୁ ତ୍  ଯୋଗାଣ ମାଧ୍ୟମରେ ଲାଭଦାୟକ ହେବ ବୋଲି  ଆଶା କରାଯାଉଛି ।
ଏହି  ପଦକ୍ଷେପର ସମର୍ଥ କମାନେ ଯୁ କ୍ତି  ଦି ଅନ୍ତି  ଯେ ଏହା ଖାଦ୍ୟ ସୁ ରକ୍ଷାକୁ  ସୁ ଦୃ ଢ଼ ​​କରି ବ, ଜଳବାୟୁ -ପ୍ର ବର୍ତ୍ତିତ ପାଣି ପାଗ ଚରମ ପ୍ର ଭାବକୁ  ହ୍ରା ସ କରି ବ, ଗ୍ରା ମାଞ୍ଚଳ ଜୀବି କାକୁ  ସମର୍ଥ ନ କରି ବ ଏବଂ
ଆଞ୍ଚଳି କ ଆର୍ଥିକ ବି କାଶରେ ଯୋଗଦାନ ଦେବ। ପରି ବେଶବି ତ୍ମାନେ ଚେତାବନୀ ଦେଇଛନ୍ତି  ଯେ ନଦୀଗୁ ଡ଼ି କର ପରି ବର୍ତ୍ତ ନ ନଦୀ ପରି ସଂସ୍ଥା, ବନ୍ୟପ୍ରା ଣୀ ବାସସ୍ଥାନ ଏବଂ ପ୍ରା କୃ ତି କ ପ୍ର ବାହ ଢାଞ୍ଚାକୁ
ପ୍ର ଭାବି ତ କରି ପାରେ। ସମ୍ପ୍ରଦାୟର ବି ସ୍ଥାପନ, ​​ଆନ୍ତଃରାଜ୍ୟ ଜଳ ବି ବାଦ, ଉଚ୍ଚ ଆର୍ଥିକ ଖର୍ଚ୍ଚ  ଏବଂ ଏହି  ପ୍ର କଳ୍ପଗୁ ଡି କର ଦୀର୍ଘ କାଳୀନ ଅବଧି  ଉପରେ ମଧ୍ୟ ଚି ନ୍ତା ପ୍ର କାଶ ପାଇଛି । ସମାଲୋଚକମାନେ
ସତର୍କ ତାର ସହି ତ ମୂ ଲ୍ୟାଙ୍କନ, ଦୃ ଢ଼ ପରି ବେଶଗତ ସୁ ରକ୍ଷା ଏବଂ ଜଳଛାୟା ବି କାଶ, ବର୍ଷା ଜଳ ଅମଳ ଏବଂ ସ୍ଥାନୀୟ ଜଳସଂଗ୍ର ହର ପୁ ନରୁ ଦ୍ଧାର ଭଳି  ବି କଳ୍ପ ଜଳ-ସଂରକ୍ଷଣ ପଦକ୍ଷେପର ଆବଶ୍ୟକତା
ଉପରେ ଗୁ ରୁ ତ୍ୱାରୋପ କରନ୍ତି  ।

ନଦୀ ସଂଯୋଗୀକରଣ ପାଇଁ  ଜାତୀୟ ଦୃ ଷ୍ଟି କୋଣ ଯୋଜନା କେବେ ଆରମ୍ଭ ହୋଇଥି ଲା ?

A.  1950

B.  1960

C.  1980

D.  2000

✓

Q68 Odia
କେଉଁ ଟି  ପ୍ର ଥମ ଅନୁ ମୋଦି ତ ପ୍ର ମୁ ଖ ନଦୀ ସଂଯୋଗ ପ୍ର କଳ୍ପ?

A.  ଗଙ୍ଗା-କାବେରୀ

B.  କେନ୍ -ବେତୱା

C.  କୃ ଷ୍ଣ-ଗୋଦାବରୀ

D.  ମହାନଦୀ-ଗୋଦାବରୀ

✓

Q69 Odia
ନଦୀ ସଂଯୋଗୀକରଣ ମୁ ଖ୍ୟ ଲକ୍ଷ୍ୟ ହେଉଛି  ______.

A.  ପର୍ଯ୍ୟ ଟନ ବୃ ଦ୍ଧି

B.  ଉଦ୍ ‌ବୃ ତ୍ତ ଠାରୁ  ଅଭାବୀ ଅବବାହି କାକୁ  ଜଳ ସ୍ଥାନାନ୍ତର କରି ବା

C.  ଅଧି କ ବନ୍ଧ ନି ର୍ମା ଣ

D.  ପରି ବହନ ଖର୍ଚ୍ଚ  ହ୍ରା ସ
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✓

Q70 Odia
ନଦୀ ସଂଯୋଗୀକରଣ ସହି ତ ଜଡି ତ ନି ମ୍ନ ଲି ଖି ତ ମଧ୍ୟରୁ  କେଉଁ ଟି  ଚି ନ୍ତାର ବି ଷୟ?

A.  ପରି ବେଶଗତ ବି ଭ୍ରା ଟ

B.  ଭାରୀ ଆର୍ଥିକ ଖର୍ଚ୍ଚ

C.  ଲୋକଙ୍କ ସମ୍ଭାବ୍ୟ ବି ସ୍ଥାପନ

D.  ଉପରୋକ୍ତ ସମସ୍ତ

✓

Q71 Odia
ନଦୀଗୁ ଡ଼ି କର ପରସ୍ପର ସଂଯୋଗୀକରଣ ମୁ ଖ୍ୟତଃ କଣ ପାଇଁ  ଲାଭଦାୟକ ହେବ ବୋଲି  ଆଶା କରାଯାଉଛି ?

A.  କୃ ଷି  ଏବଂ ଜଳ ଯୋଗାଣ

B.  ପର୍ଯ୍ୟ ଟନ ଶି ଳ୍ପ

C.  ଖଣି  କ୍ଷେତ୍ର

D.  ବି ମାନ ପରି ବହନ

✓

Q72 Odia
ମି ଶି ଯାଏ ଯଥା ପ୍ର ଭାତୀ ତାରା ରବି  କି ରଣ - କେଉଁ  ପଦଟି  ସାଦୃ ଶ୍ୟବୋଧକ ଅବ୍ୟୟ ।

A.  ମି ଶି ଯାଏ

B.  ପ୍ର ଭାତୀ

C.  ତାରା

D.  ଯଥା

✓

Q73 Odia
“ସ୍ଵକୀୟ” ର ବି ପରୀତ ଶବ୍ଦ ଲେଖ ।

A.  ମର୍ତ୍ତ୍ୟ

B.  ରୁ କ୍ଷ

C.  ପରକୀୟ

D.  ଅକ୍ଷତ

✓

Q74 Odia
ସଠି କ୍  ବନାନ ଥି ବା ବାକ୍ୟଟି  ଚି ହ୍ନଟ କର ।

A.  ସେ ଯଣେ କୃ ତବି ଦ୍ୟା ବ୍ୟକ୍ତି  ।

B.  ସେ ଜଣେ କୃ ତବି ଦ୍ୟ ବ୍ୟକ୍ତି  ।

C.  ସେ ଯଣେ କୃ ତି ବି ଦ୍ୟ ବ୍ୟକ୍ତି  ।

D.  ସେ ଜଣେ କୃ ତବି ଦ୍ଧ ବ୍ୟକ୍ତି  ।

✓

Q75 Odia
"ପକ୍ଷୀଟି  ଉପରକୁ  ଉଡ଼ି ଗଲା" ଏଠାରେ 'ଉପରକୁ ' କି  ପ୍ର କାର କ୍ରି  ୟା ବି ଶେଷଣ?

A.  କାଳବାଚକ

B.  ସ୍ଥାନବାଚକ

C.  ଗୁ ଣବାଚକ

D.  ପରି ମାଣବାଚକ
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Computer

✓

Q76 Computer
Which shortcut key starts a PowerPoint slide show from the
beginning?

A.  F5

B.  F7

C.  F9

D.  Ctrl + S

✓

Q77 Computer
Which keyboard key confirms cell edits after typing in MS Excel
2021?

A.  Shift

B.  Esc

C.  Enter

D.  Ctrl

✓

Q78 Computer
In PowerPoint, which of the following is a correct step to open an
existing presentation file saved on PC?

A.  File → New → Blank Presentation

B.  File → Open → Select the file → Click Open

C.  Home tab → Insert → Slide Show

D.  View tab → Slide Sorter → Double click file

✓

Q79 Computer
If you want your presentation to start automatically when the file is
opened (without entering editing mode), you should save as:

A.  .pptx

B.  .ppsx

C.  .potx

D.  .odp

✓

Q80 Computer
While sending an email with an attachment, which of the following
steps is correct?

A.  Type the message and click Send before attaching the file.

B.  Attach the file using the paperclip icon before sending the
email.

C.  Copy and paste the file into the subject line.

D.  Rename the file to “Attachment” and skip uploading it.

✓

Q81 Computer
Which feature in an email program automatically checks spelling
mistakes while writing an email?

A.  Email Signature

B.  Spell Check

C.  Attachment

D.  Drafts

✓

Q82 Computer

In the context of Formatting Documents in MS Word 2021, match
the options in Column A with their corresponding functions in
Column B.

Column A – Text
Option

Column B – Function

1. Cut
a) Duplicates the selected text to the clipboard
without deleting it

2. Copy b) Deletes the selected text and places it on the
clipboard

3. Paste
c) Adds the content from the clipboard to the
current cursor location

4. Undo d) Cancels or reverses the most recent editing
or formatting action

A.  1–b, 2–a, 3–c, 4–d

B.  1–a, 2–b, 3–d, 4–c

C.  1–b, 2–c, 3–a, 4–d

D.  1–d, 2–b, 3–c, 4–a

✓

Q83 Computer
Which is the brain of the computer?

A.  Input Device

B.  Output Device

C.  Memory Device

D.  Central Processing Unit

✓

Q84 Computer
Who is known as the Father of Computers?

A.  Charles Babbage

B.  Vinton Cerf

C.  Alan Turing

D.  Ivan Misner
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✓

Q85 Computer
Which component of OS handles memory allocation?

A.  Process Manager

B.  Memory Manager

C.  File Manager

D.  I/O Manager

✓

Q86 Computer
In Microsoft Office Professional 2021, where can we find the bullets
tab?

A.  Under Design tab, in the Document formatting group

B.  Under Layout tab, in the Paragraph group

C.  Under Home tab, in the Paragraph group

D.  Under Insert tab, in the Pages group

✓

Q87 Computer
Which of the following is NOT a valid data type in MS Excel?

A.  Text

B.  Number

C.  Date

D.  Image

✓

Q88 Computer
What is the primary function of a PCB in electronic devices?

A.  To store operating system data

B.  To mechanically support and electrically connect
components

C.  To increase wireless signal strength

D.  To cool down the CPU

✓

Q89 Computer
When you search for help in MS Word using the search box, what
type of results will you typically see first?

A.  Video tutorials from YouTube

B.  Help articles and step-by-step instructions

C.  User comments and reviews

D.  Software update notifications

✓

Q90 Computer
In Microsoft Excel, which option allows you to start with a blank
spreadsheet?

A.  File > Open

B.  File > Print

C.  File > New > Blank Workbook

D.  View > Gridlines
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Reasoning

✓

Q91 Reasoning
In a certain code language,
'A # B' means ‘A is the wife of B’,
'A % B' means ‘A is the brother of B’,
'A $ B' means ‘A is the father of B’ and
'A @ B' means ‘A is the mother of B’.

How is L related to P if ‘L $ A % N @ S # P’?
1967

A.  Wife's father

B.  Wife’s father’s father

C.  Wife’s mother’s sister

D.  Wife's mother's father

✓

Q92 Reasoning
Eight people are sitting in a circle (A, B, C, D, E, F, G and H) facing the
centre. D is sitting third to the right of A. B is sitting second to the
left of A. How many people are sitting between D and B when
counted from the right of D?2292

A.  Four

B.  Three

C.  Two

D.  Five

✓

Q93 Reasoning
Seven boxes F, G, H, I, U, V and W are kept one over the other but
not necessarily in the same order. No box is kept above I. Only three
boxes are kept between I and U. Only one box is kept between H
and F. F is kept just above U. Only four boxes are kept between H
and W. V is kept at some place above G.
Which box is kept second below V?

A.  F

B.  H

C.  U

D.  W

✓

Q94 Reasoning
Which of the following letter-number clusters will replace the
question mark (?) in the given series to make it logically complete?

THE98, PDA89, LZW80, HVS71, ?

A.  DRO62

B.  DIO62

C.  DRU62

D.  SRO62

✓

Q95 Reasoning

What will come in the place of ‘?’ in the following
equation, if ‘+’ and ‘ – ‘ are interchanged and ‘×’
and ‘÷’ are interchanged?
15 – 49 × 7 + 8 ÷ 2 = ?

A.  6

B.  12

C.  22

D.  28

✓

Q96 Reasoning
OF 21 is related to MC 3 in a certain way. In the same way, JL 28 is
related to HI 10. To which of the following is NG 24 related, following
the same logic?

A.  LD 6

B.  KO 8

C.  BH 5

D.  VG 4

✓

Q97 Reasoning
In a certain code language, ‘pan fresh oven’ is coded as 'sm al zu'
and ‘oven unit giant’ is coded as ‘al xq hj’. How is ‘oven’ coded in that
language?

A.  al

B.  sm

C.  zu

D.  xq

✓

Q98 Reasoning
Based on the English alphabetical order, three of the following four
letter-cluster pairs are alike in a certain way and thus form a group.
Which is the one that does not belong to that group? (Note: The odd
one out is not based on the number of consonants/vowels or their
position in the letter cluster.)6187

A.  BC-FG

B.  GH-JK

C.  ST-VW

D.  MN-PQ
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✓

Q99 Reasoning
Refer to the following series and answer the question that follows.
Counting to be done from left to right only. (Note: All numbers are
single-digit numbers only.)

(Left) 9 6 8 5 8 5 9 8 6 3 6 6 3 6 8 6 7 1 1 9 9 8 8 7 1 1 4 (Right)

How many such even numbers are there, each of which is
immediately preceded by a perfect square and immediately followed
by an even number?
(NOTE: 1 is also a perfect square.)3343

A.  Three

B.  Two

C.  One

D.  Four

✓

Q100 Reasoning
Read the given statement(s) and conclusions carefully. Assuming
that the information given in the statements is true, even if it
appears to be at variance with commonly known facts, decide which
of the given conclusions logically follow(s) from the statement(s).
Statements: All jams are cobras. All cobras are mugs.
Conclusions (I) : Some mugs are cobras
Conclusions (II) : All jams are mugs8620

A.  Both conclusions (I) and (II) follow

B.  Neither conclusion (I) nor (II) follows

C.  Only conclusion (II) follows

D.  Only conclusion (I) follows
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